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AEM-XTM Connector Introduction

This manual describes how to install, configure and use the modules required for Adobe Experience Manager to integrate with XTM.

General information

® AEM has a synchronous line per line translation mode, this is generally referred to as Translation API 1.0 and is always an MT type of

translation.
AEM has asynchronous per document translation referred to as Translation APl 2.0 and can be either human- or machine-
translation.

AEM-XTM Connector Prerequisites

This document describes prerequisites for integrating XTM with Adobe Experience Manager 6.1.

Prerequisites

[ ]
eAccess to an AEM 6.1 installation
Acces to an XTM server

Installing XTM Connect for AEM

To use the XTM Connect for AEM as a translation provider you can download the XTM connector package from Package Share. After installing
the package you can create a cloud configuration as is described in Configuring the AEM-XTM Connector.

Working with Packages
For more information on how to work with packages, please refer to http://docs.adobe.com/docs/en/aem/6-1/administer/content/packag
e-manager.html.

Summary of steps:

® Obtain the CrossLang XTM package
® Upload the package
® Install the package

Obtaining the XTM Connect Package from Adobe Package Share
To obtain the XTM package, proceed as follows:

1. Open a browser and navigate to https://www.adobeaemcloud.com/content/packageshare.html:
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Clouds Packages Services Contest Joeri Van de Walle

4 Back to Packages Upload

ADOBE ¥ SHARED T PRIVATE

‘Showing featured Adobe packages

E-commerce

A module that accelerates CQ integration w mmerce platforms so
marketers can quickly deliver branded, personalized shopping experiences
Bimobile, and social touchpo

Elastic Path Showcase Demo
Provider:

Version: 1.66

Published: 01 Sep 2015

cq-6.1.0-apps-featurepack-...
Provider: Adobe Systems Incorporated
Version: 1.0.6

Published: 26 Aug 2015

& 9 & 9

¢g-6.0.0-hotfix-7026

Provider: Adobe Systems Incorporated
Version: 1.2

Published: 26 Aug 2015

cg-6.1.0-hotfix-6449

Provider: Adobe Systems Incorporated
Version: 1.2
Published: 23 Aug 2015

& 9
2. Find the CrossLang XTM for Adobe Experience Manager package:

& 9

Clouds Packages Services Contest Joeri Van de Walle

4 Back to Packages Upload
CrossLang XTM ADOBE T SHARED T  PRIVATE 2R Four
Showing CrosLeng % OF XTM x in Adobe + Shared + Private [or @ avo @

Social Communitie

A fully integrated solution that enable marketers]
social experiences as part of their website to by
generate demand.

CrossLang-XTM-Translation... crosslang-xtm
> Provider: CrossLang NV Owner: crosslang
Version: 1.0.1 Version: 1.0.0.20150519
International Published: 02 Jul 2015 Published: 20 May 2015
g CrossLNG

& 9 & 9

3. Click on the CrossLang-XTM-Translation-Connector tile to see the package's details and download the package using the download link
provided on the Assets tab:
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Clouds Packages Services Contest Joeri Van de Walle

4 Back to Package Share

CROSSLANG- Install ‘

) XTM-TRANSLATION-

International CONNECTOR Read EULA

iang  Provider: CrossLang NV
§ Distribution: Publicly available

Products:

“0.

-
9
b

DESCRIPTION DETAILS SCREENSHOTS

Download to disk: CrossLang-XTM-Translation-Connector-1.0.1

ED. ALL RIGHTS RESERVED

ABOUT ADOBE® EXPERIENCE MANAGER  HELP  TERMS

Uploading the CrossLang XTM Package
To upload the CrossLang XTM package, proceed as follows:

1. Log in to your AEM instance and navigate to Tools » Operations » Packaging » Packages:
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@ Reset @ | [search packages E () Create Package  Upload Package admin@crx.defautt v
~
Sort by . " B
cq-content-insight-content-1.1.30.zip @O Share | 2081 KB
Version: 1.1.30 | Last installed Jun 10 | admin
Name - Content package for the Content Insight and Recommendations module
Last modified
Installation date
= com.adobe.cq.betafeedback.content-0.1.12.zip @O Share | 43.3KB
s Version: 0.1.12 | Last installed Jun 10 | admin
| The parent project to the Communique 5 parts
New packages . " .
nstallen Buit o com.adobe.cq.betafeedback.quickstart-pkg-0.1.10.zip @@ share | 543x8
Version: 0.1.10 | Last installed Jun 10 | admin
The parent project to the Communique 5 parts
Groups
my_packages - cq-projects-translation-content-0.0.50.zip @D Share | 2462 KB
‘Adobe (1) Version: 0.0.50 | Last installed Jun 10 | admin
“Adobe (44). - Content package for Adobe CQ Translation Projects
aemfd (1)
com (1
com.adobe.cq (2) — cq-projects—content-1.1.116.zip @O Share | 46 MB
o Ee e e Version: 1.1.116 | Last installed Jun 10 | admin
"é,ossla"g o Content package for the projects module
day (84)
— cq-d: jelivery-bundl 1.0.26.zip @D Share | 75.4 MB
| | Version: 1.0.26 | Last installed Jun 10 | admin
Adobe CQ DAM bundles used in both author and delivery environments
cq-dam-bundles—content-1.0.182.zip @O Share | 5.6 MB
Version: 1.0.182 | Last installed Jun 10 | admin
Installation package that contains bundis for CQS DAM
- «q () 'ms—il8n—c -2.1.8.zip @O Share | 250.1 KB
Version: 2.1.8 | Last installed jun 10 | admin
Content package for the internationalization module o
| Activity Log 2l

2. Click Upload Package, then Browse, and find the package that you download from Adobe Package Share:

@ | [Search packages || @ createPackage | Upload Package admin@crx.default v

cq-content-insight-content-1.1.30.zip @D Share | 2081 KB i
Version: 1.1.30 | Last installed jun 10 | admin ||
Content package for the Content Insight and Recommendations module

Last modified

Installation date

Recently added

com.adobe.cq.betafeedback.content-0.1.12.zip @0 Share | 433KB
Version: 0.1.12 | Last installed Jun 10 | admin
show. The parent project to the Communique 5 parts

Ne
|}§m|;|‘:::i: o o — com.adobe.cq.betafeedback.quickstart-pkg-0.1.10.zip @3 Share | 543 kB
L - Version: 0.1.10 | Last installed jun 10 | admin

The parent project to the Communique 5 parts

[x]|

€q-proj{ | Ppackage: CrossLang-XTM-Translation-Connectol ‘Bmm-e F‘ | 2462 KB

i R i [ | Version: 0.
orsbedty " Force Upload: [
‘Adobe (44) Content paf

Check to overwrite existing packages.
aemfd (1)

“com.adobe.cq (2)

Cq—proj [ | 46ME
Mook | o[ oama ] [

com.adobe cq betafeedback (2)

Content package for the projects madule

crosslang (1)

day (84)

fd

‘mobileapp cq—d. Y 1.0.26.zip @ Share | 754 MB

A 2 Version: 1.0.26 | Last installed Jun 10 | admin

sling

- Adobe CQ DAM bundles used in both author and delivery environments
cq-dam-bundles—content-1.0.182.zip @O Share | S6ME
Version: 1.0.182 | Last installed Jun 10 | admin
Installation package that contains bundis for CO5 DAM
cq-adaptiveft i18n—C —-2.1.8.zip @0 Share | 250.1 KB
Version: 2.1.8 | Last installed jun 10 | admin
Content package for the Internationalization module

>l <

| Activity Log
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Installing the CrossLang XTM Package
To install the CrossLang XTM package, proceed as follows:

1. Click Install to install the package:

@ tem @ e pmoiage £ Qowmmrensge  Speet Paciege S Gers etk -

Jort by Crosstang-XTM- Franslation-Connector- 1.0.1 zip W e v

Versesn 100 | St | Lont Butt ot 2 | atewn

f‘
k

WM for A%

. ALM 4

Lam mosfud 9 wes
slang TTM vt ity | fvewwn sransipeg smm

msrancn tats
Recansty asced

«q-content -inssght -content - 1.1.30.2p BT Shwe | e
Versoe 1130 | Last wutated fum 10 | ades

I?

e packagre
wataied Bow
com.adobe.cq.betaleedback.content -0.1.12.21p BT e | 3
Versias O 1 12 | Last mwtated fun 10 | sdeen

I?

EREREEE

oy awiagny
Adces (1)
imarteg
Ascee (440
anebi (1)

com.adobe.cq. betaleedback quickstart - pkg-0.1.10.21p @9 e | S0 100

Vorson' 0110 | Last svstated jom 10 | adwam

eoen (1)
cown wdote 04 (1)
Cone mdota <0 betafenstack (1)

«q-progects-translation -content -0.0,50 zip B Shan | I
Vornian: 0050 1 Lant stated Jn 10 | adwen

crowiang (1) Caniont pockape #50 ASSH CG Tyassiative Aayert
duy (M
]
omienmy «q-projects-content- 1.1, 116.0p B Shwe | A4
g Vardenn 111160 LK maased fen 10 | ase
cq-dam-delwery-bundies-content-1.0.26.2p B Shaw | A
Varsion 10 26 | Lt watabed fusn 10 | sdown
cq-dam-bundles content - 1.0.182_zip W ke | Sae
‘ﬁj Versme | 0 162 | Latt svilases Jus 10 1 st ]
Aoty g )

2. The package is now installed and ready for use:

@ Reset @ | [Search packages |£| @ Create Package | Upload Package admin@crx defautt +
~
Sort by iy £ s = =
> CrossLang-XTM-Translation-Connector-1.0.1.zip @D Share | 9MB
waensioos  Version: 1.0.1 | Build: 9 | Last installed 14:50 | admin

Name CrossLang XTM for Adobe Experience Manager 6.1. This connector allows you
= a o i to translate AEM 6.1. content with XTM. For more information about

CrossLang XTM visit http:/ /www.crossiang.com

Recently added

cq-content-insight-content-1.1.30.zip @D Share | 208.1 KB
Show Version: 1.1.30 | Last installed Jun 10 | admin
Content package for the Content Insight and Recommendations module
New packages i i
Installed/Built
com.adobe.cq.betafeedback.content-0.1.12.zip @D Share | 43.3KB
Version: 0.1.12 | Last installed Jun 10 | admin
Groups The parent project to the Communique 5 parts

.Ar‘lgbeb(bl) com.adobe.cq.betafeedback.quickstart-pkg-0.1.10.zip @[ share | 543x8

e Version: 0.1.10 | Last installed jun 10 | admin
‘Adobe (44) The parent project to the Communique 5 parts
aemfd (1)

com (1)

com.adobe.cq (2) €q-proj lati 0.0.50.zip @O Share | 2462 K8

com.adobe.cq betafeedback (2 Version: 0.0.50 | Last installed Jun 10 | admin
Crosstang (1) Content package for Adobe CQ Translation Projects
day (84)

fd

S St R AT E S T

Version: 1.1.116 | Last installed jun 10 | admin

Content package for the projects module

cq-dam-delivery-bundl -1.0.26.zip @D Share | 75.4MB
Version: 1.0.26 | Last installed Jun 10 | admin

Adobe CQ DAM bundies used in both author and delivery environments

cq-dam-bundles-content-1.0.182.zip @O Share | 5.6 MB
Version: 1.0.182 | Last installed Jun 10 | admin )

| Activity Log 2]

P E EEEEE
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Configuring the AEM-XTM Connector

This section describes the minimal configuration that is needed to make the integration work.

Creating the Cloud Service Configuration

After having uploaded the CrossLang-XTM-Translation-Connector package, a cloud service configuration need to be created.

To create a CrossLang XTM configuration, proceed as follows:

1. Navigate to Tools » Operations » Cloud » Cloud Services.
2. In the Third Party Services section, scroll to the CrossLang XTM service and click Configure now if this is the first configuration you are

creating for the service or Show Configurations and then [+] if you want to add an additional configuration to existing configurations.
3. Specify the following information:

Create Configuration b
~
Parent Configuration® | /etc/cloudservices/xtm-translation P
Title®
Mame
CrossLang XTHM configuration
> Account settings for XTM transiation access
Internationa
L
Create Cancel

Parent Configuration: Keep suggested value.
Title: This is the name of the configuration as it will be shown in the AEM interface. Can be any value.

Name: This is the internal name that AEM uses. The name cannot contain spaces.

4. Click Create.
5. Specify the basic CrossLang XTM Configuration parameters:
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CrossLang XTM Configuration X
Config

Web Service URI* I l

Company* l _ ‘
User Id* l : ‘
Password* I l
Verify XTM‘ connection
Customer =
Project Template | | v

Cancel

Web Service URI: This is the location at which the XTM web service can be reached. E.qg. "http://wstest2.xtm-intl.com/project-manager-
g ui/services/v2/XTMProjectManagerMTOMWebService".
Company: This is the Company as specified in XTM. E.g. "Test Customer".
User Id: This is the unique user Id of the XTM user that will be used for the interaction with XTM. E.g. "1234".
Password: This is the password of the XTM user that will be used for the interaction with XTM. E.g. "p4SSwOrd".
6. Click Verify XTM connection.
a. If the connection can successfully be established, the Customer drop-down will be populated with the Customers available in
XTM.
b. If the connection cannot be established, review and correct the specified values and try again until the connection passes.
7. Select the XTM Customer under which projects created by AEM will be created in XTM. Once a Customer has been selected, the Proje
ct Template drop-down will be populated with the templates available in XTM for the selected Customer.
8. Select the XTM Project Template to be used for the projects created by AEM in XTM.

Note: Multiple CrossLang XTM configurations can be created to provide for different needs. A typical use case, for instance, would be different
web site section with different translation process requirements. Some content may not require review whereas other content might. In that case,
the user may want to create two CrossLang XTM configurations: one with a Project Template selected that includes a Review and Correct step,
and another that does not include those steps.

Applying the Cloud Service Configuration
Once the required cloud service configurations have been created, they need to be applied at the desired level of your Site hierarchy.

To apply a cloud service configuration, proceed as follows:
1. Navigate to Sites, then to node in the site hierarchy at which level you want to apply the configuration.
2. Click the node to which you want to apply the configuration. For example, the top level of the site:
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Adobe Marketi < Geometrixx Demo Site

Experience Manager 5 h @ Tir

Projects Campaigns > English
Sites Community Sites > Frangais
Apps Geometrixx Outdoors Site > Deutsch
Publications . Geometrixx Outdoors Mo... > _ Espariol
Geometrixx Demo Site > _ ltaliano

GeometrioMobile Demo . > SR B#sl

Grometo:Medu > N s

Personalization Geometrixx Gov > _ Nederlands
Communities
Commerce

Tools

3. Click View Properties, then CLOUD SERVICES:

< Properties

Q Adobe Marketing Cloud

@ Experience Manager K4
Projects

BASIC ADVANCED UMBNAIL CLOUD SERVICES

Sites

Beta Feedback H

Help 0o

10

elp (1]

Beta Feedback

Translation Integration

fipps Default configuration - Geometrixx Samples

Publications CrossLang XTM

XTM Test Config
Forms

Assets

Screens
Personalization
Communities
Commerce

Tools

4. Click Edit:

XTM Connect for Adobe AEM 10
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11

Adobe Marketing Cloud < Properties Help © Beta Feedback

Experience Manager ¥ Goncel &/ Done

Apps

Publications Default configuration - Geometrixx Samples V|| —

Forms

Assets Add Configuration =+
Screens

Personalization

Communities

Commerce

Tools

5. Click the + sign next to Add Configuration under Cloud Service Configurations and select CrossLang XTM from the drop-down:

©) Adobe Marketing Cloud < Properties Help © Beta Feedback
Experience Manager X G Vv I
Projects BASIC DVANCED THUMBNA CLOUD SERVICES

Sites
Translation Integration
Apps

Publications Default configuration - Geometrixx Samples Vo

Forms

CrossLang XTM
Assets : Refe
XTM Test Config V-
Screens
Personalization 7
Add Configuration +

Communities

Commerce

Tools

6. Select the desired CrossLang XTM configuration from the CrossLang XTM Configuration Reference drop-down:

11
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7. Click Done to confirm the configuration changes made.

Q Adobe Marketing Cloud

@ Experience Manager

Projects

Sites

Apps

Publications

Forms

Assets

Screens

Personalization

Communities

Commerce

Tools

< Properties

AEM is now ready to submit content to XTM.

CLOUD SERVICES

Translation Integration

Default configuration - Geometrixx Samples

CrossLang XTM

Help 0o

XTM Test Config

Add Configuration

Using the AEM-XTM Connector

This section describes the basic steps for translating AEM content with XTM.

Summary of steps:

Create a translation project

(Optional) Scope the translation job

Start the translation job
Complete the translation job

Creating a Translation Project

To create a translation project, proceed as follows:

=+

1. Navigate to Sites, then to the node in the source language's site hierarchy that you wish to create a translation project for:

XTM Connect for Adobe AEM
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13

Q Adobe Marketing Cloud < Circle Beta Feedback Help o
@ Experience Manager Sear @ Time L Reference 4+ Ceate e o Pronectias see . elected m
Projects English > B Toolbar > Triangle > TEERS  Overview
]
Sites Frangais > WEES  Products > Square > RS Features
] ]
Apps Deutsch > TEES  Services >
]
Publications Espafiol > WEES  Company > WEES  Mandelbrot Set >
] L}
Forms Italiano > WEERS  Support >
]
Assets BREE > ERS  Community >
]
[ees——
Screens AP > GeoBlog >
]

Personalization Nederlands >
Communities
Commerce

Tools

2. Click References to open up the References panel and expand the Language Copies section:

\g Adobe Marketing Cloud < Circle Beta Feedback Help ©
@ Experience Manager < References jo @ Timel -6 References 4+ Ceat ess More elected n
Projects LENcAcEconD L) English > "ERS  Toolbar > RS Triangle >
. " L] L}
Cnrele. EN (L8 |
Sites [ > R Products > WBE squoe >
Circle NL | AERN .
Apps [ I > RS Services > Circle
(L8 | .
Publications il Espaiol > "ERS  Company > TERS  Mandelbrot Set >
(Lo} e .
Forms [ > "ERS  Support >
AENN e
Assets il B > RS Community >
(L8 | .
S [
Screens - EiEPIT > GeoBlog >
(Can | =
Personalization e >
L]
Communities
Commerce
Tools
Create & Translate N
< >

3. Click Create & Translate and select the language copies you wish to add (Check Select all sub-pages if you wish to include all child
pages of the selected node in the translation project). From the Project drop-down, select whether you want to create a new project or
add the selected nodes to an existing one:

13
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14

Q Adobe Marketing Cloud < Circle Beta Feedback Help 0
@ Experience Manager < References jo) @ Timeline -6 References =+ Ceat ses Mo elected ][]
LANGUAGE COPIES " "
Projects - English > RS Toolbar > "ERS  Triangle >
- L} L}
i EN
Sites Francais > RS Products > TERS  Square >
L}
NL
Apps Deutsch > RS Services > Circle
L}
Publications Espaiiol > RS Company > ERSE  Mandelbrot Set >
L} L}
Forms ltaliano > RS Support >
L}
Assets BREE > RS Community >
L}
Create & Translate V2 i
Screens - EiEpIT > GeoBlog >
It -]
Personalization Y cane >
Select languages v
(L8]
Communities X French
Commerce v/ Select all sub-pages
Project
Tools
Create a new translation project V'
< >

4. Specify a name for the translation project in the Title field and click Create to create the project:

©) Adobe Marketing Cloud < Cdircle BetaFeedback  Help 0
@ Experience Manager < References O Sea @ Timeline -6 References =+ Ceate ess More elected Ml cow
LANGUAGE COPIES " "
Projects - English > RS Toolbar > RS Triangle >
Circle A . s
- X EN
Sites Francais > "ERS  Products > RS square >
Circle .
R NL
Apps Deutsch > ‘ﬂ.(‘. Services > Circle
Publications Espafiol > "ERS  Company > Mandelbrot Set >
L}
Forms ltaliano > "ERS  Support >
L}
Assets > RS Community >
L}
Create & Translate V. [—
Screens - EiEPIT > GeoBlog >
Personalization e >
Select languages v BN
Communities X French
Commerce Vv Select all sub-pages
Tools 2z
Create a new translation project V'
‘ Products-Circle ‘
< >
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Scoping a Translation Job

Upon creating a translation project, AEM will automatically create a translation job under it that holds the site pages that were selected for

translation.

To scope the translation job, proceed as follows:

1. Navigate to Projects > [name_of_project_just_created]:

'@ Adobe Marketing Cloud < Products-Circle [FR]

xperience Manager Select + Add Tile

Projects

Products-Circle [FR]

Sites

! Administrator
Apps

Language
Publications French

Provider
XTM Translation Service

Method

Human Translation
Personalization

Communities

Commerce

Tools

Translation Job
Status

Pages
Assets

The Team (1)

1

2. Select Request Scope from the drop-down in the Translation Job section:

XTM Connect for Adobe AEM

15

Draft

Beta Feedback Help

15

0

v Tasks (0)
100%

Active

sese
8 Completed
e
e
15
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16

) Adobe Marketing Cloud < Products-Circle [FR] BetaFeedback Help 0

Experience Manager

Products-Circle [FR] Translation Job v Tasks (0)
Sit
e Sl # Request Scope
- Pages

Ao ! Administrator e i

Language 1
Publications French e 1 O O %

E

Provider ® beed

XTM Translation Service 4 Due Date

Method

Human Translation

Active
see
i Completed
Personalization
The Team (1)
Communities
Commerce
Tools
e
. in the Translation Job section to see the Translation Job's contents and check on scoping request progress:
£ Translation Job Beta Feedback

Experience Manager

Projects Title Status Asset Type

Sites

Circle te
Apps
PP Overview content/geometrixod/friproducts/circle/overview e Submitted
Publications
Features e

cir_circle.png

sq_elipsepng content/dam/geometrinx/shapes/sq_el e e

cir_sphere.png content/dam/geometrixshapes/cir_spherepng Submitted
Personalization

ASSETMETADATA B Submitted Assets Metadate
Communities

TAGMETADATA T

Commerce

Tools

Once scoping is completed, the Translation Job status changes to Scope Completed.
4. Click Show Scope to see scoping information:
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O Adobe Marketing Cloud

@ Experience Manager

Projects

Sites

Apps

Publications

Forms

Assets

Screens

Personalization

Communities

Scoping information is shown:

O Adobe Marketing Cloud
Experience Manager
Projects

Sites

Apps

Publications

Forms

Assets

Screens

Personalization

Communities

Commerce

Tools

XTM Connect for Adobe AEM

< Products-Circle [FR]

Administrator

Language
French

Provider
XTM Translation Service

Method
Human Translation

< Products-Circle [FR]

Products-Circle [FR]

! Administrator

Language
French

Provider
XTM Translation Service

Method
Human Translation

Beta Feedback Help

Tr Job v =+
Status S| 8 Show Scope
Pages 3
Assets 3 © Start
£3 Due Date 0,
100%
Active
eee
Completed
eoe
Beta Feedback Help
Translation Job v Tasks (0) + The Team (1)
Status Scope Completed
Pages 3
Assets 3
9%
Scope x 1 OO (o}
Word Count 246
Video Count [¢]
Image Count 0
Estimated Cost 150.00
Machine Translation 0
Repetitions 0 Active
84-75% Match 0
100% Match 0
99-95% Match 0 ' Completed
94-85% Match 0
In-Context Match 0

17
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Starting a Translation Job

To start a translation job, proceed as follows:

1. Navigate to Projects > [name_of_project_just_created]:

©) Adobe Marketing Cloud

Experience Manager

Projects

Sites

Apps

Publications

Forms

Assets

Screens

Personalization

Communities

Commerce

Tools

2. Select Start from the drop-down in the Translation Job section:

Q Adobe Marketing Cloud

Experience Manager

Projects

Sites

Apps
Publications
Forms

Assets

Screens
Personalization
Communities
Commerce

Tools

XTM Connect for Adobe AEM

< Products-Circle [FR]

Products-C

2 Administrator

Language
French

Provider
XTM Translation Service

Method
Human Translation

< Products-Circle [FR]

+

Products-Circle [FR]

z Administrator

Language
French

Provider
XTM Translation Service

Method
Human Translation

Translation Job

Status
Pages
Assets

Translation Job

Status
Pages
Assets
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Scope Completed
3
3

eoe
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3

3 O Start

2 Show Scope
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cee
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Tasks (0 ute The Team (1)

100%

Active
8 Completed
eoe
Beta Feedback Help
Tasks (0 =+ The Team (1)
(o)
100%
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+ Completed
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The translation workflow is now initiated on the side of XTM.
3. Click on ... in the Translation Job section to see the Translation Job's contents and check on translation progress:

(©) Adobe Marketing Cloud { Translation Job Beta Feedback
; Experience Manager
Projects Title Status

Asset Type

Sites

Circle
App: Overview content/geometriboc/ir/products/circle/overview
Publications

Features content/geometrioc/fr/products/circlefeatures e Translation in progress

Forms
cir_circle png content/dam/geometrixoc/shapes/cir_circlepng e Translatio

Assets
sq_elipse.png content/dam/geometriodshapes/sq_elipsepng le Translation in progress
Screens
cir_sphere.png
Personalization
ASSETMETADATA
Communities

TAGMETADATA e 2 R Tags
Commerce

Tools

Completing a Translation Job

A translation job that has been started will move through the workflow steps of the workflow that was configured as part of the XTM Project
Template that was selected for the XTM CrossLang cloud configuration.

AEM will check the status of submitted pages and assets at a configured interval.

When a page or assets is found to have all workflow steps completed, AEM will automatically retrieve it and show it with status 'Ready for review'
in the translation job:
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(@) Adobe Marketing Cloud < Translation Job Beta Feedback

Experience Manager

Projects Title Status Asset Type

Sites

Circle
Apps O content/eeometrboc/fr/productsfcircle fovervie
Publications
Features &

Forms
cir_circle png

sq_elipse.png content/dam/geometrixodshapes/sq_elipsepng le Ready for revies

cir_sphere.png content/dam/geometriodshapes/cir_sphe
Personalization

ASSETMETADATA e Ready for revie Assets Metadata
Communities

TAGMETADATA E Ready for reviev

Commerce

Translated pages and assets can now be reviewed in AEM.
Once all pages have been reviewed, the Translation Job can be completed as follows:

1. Navigate to Projects > [name_of_project_just_created]:

=

@ Experience Manager Beta Feedback Help [}
Projects

Sites

Apps Status Ready for review
R Pages 3
2 Administrator Aesat 5
Publications ssets -
Language
100%
Provider
Assets XTM Translation Service
Screens Mathod
Human Translation
Active
eee eee
Personalization
P Completed
Communities
cee

Commerce

Tools

2. Select Complete from the drop-down in the Translation Job section:
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N Mar r Projects
Experience Manager < Products-Circle [FR] Beta Feedback | Help
Projects T + AddTie

Sites _

Translation Job v Tasks (0) ope

Apps Status F 2 Show Scope
R Pages 3
l Administrator B
Assets 2 @ Complete

Publications

Language

Forms French 1 O O %

Provider
Assets XTM Translation Service
Screens Mathod

Human Translation o

Ctive
Personalization =
P Completed
Communities
cee
Commerce
Tools
The translation job's status now changes to Completed:
©) Adobe Marketing Cloud < Products-Circle [FR] Beta Feedback  Help
Experience Manager elect +
Projects
Translation Job v Tasks (0 +
Sites Status Complete
R Pages 3

Apps E Administrator A 3 I

Language
Publications French 1 O O %

Provider
Forms XTM Translation Service
Assets Method

Human Translation P

ctive
Screens e
cee Completed

Personalization

Communities

Commerce

Tools
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